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Abstract

This document is a printable version of the Interaction Feedback help.
Interaction Feedback is an IC Business Manager application program
module that supports automated post-call customer satisfaction
surveys and on-demand surveys. Interaction Feedback has an intuitive
user interface to help you build effective satisfaction surveys that ask
your customers discerning questions about your company's products
and services.
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Documentation Library at: http://help.genesys.com/cic.

For copyright and trademark information, see
https://help.genesys.com/cic/desktop/copyright_and_trademark_information.htm.

1

http://help.genesys.com/cic
https://help.genesys.com/cic/desktop/copyright_and_trademark_information.htm


2
5
5
5
5
5
5
6
7
9

10
11
11
11
11
12
12
13
13
13
14
14
15
15
15
16
16
16
16
16
16
16
17
17
17
17
17
19
19
20
20
21
22
22
23
23
24
24
24
24
25
25
26
26
29
29
30
30
30
31
31

Table of Contents
Table of Contents
About Interaction Feedback

Interaction Feedback Client
Real-time monitoring in IC Business Manager
Interaction Feedback Reports
Interaction Administrator configuration

Related Topics
Interaction Feedback User Interface
Interaction Feedback Navigation Pane

Related Topics
Review Interaction Feedback Resources
Creating Customer Surveys

About Customer Surveys
Creating Surveys

Customized surveys
Creating a Survey Group
Adding a Survey to a Group
Adding Questions to a Survey

Adding questions when creating a survey
Adding questions to an existing survey

Editing Questions
Adding branching logic to a survey
Activating a Survey

Activating a survey in Survey view
Activating a survey in Survey Activation view

Deactivating a Survey
Deactivating a survey in Survey view
Deactivating a survey in Survey Activation view

Survey View
Type
Name
Description
Rank Group
Record calls that use this survey
Minimum Acceptable Score
Rule
Prompts

Creating Templates
About Templates
Creating Survey Templates
Creating Question Templates
Deleting Custom Questions from the Library

Viewing Survey Results
Viewing Survey Results in Interaction Feedback
Viewing Survey Results in the Dashboard

Managing the Dashboard
Dashboard View
Dashboard Speedometer
Refreshing the Dashboard view
Defining Surveys to display in the Dashboard

Viewing Survey Results Using Searches
Create a search
Search order
Run a search

Monitoring Surveys in Real-Time
For more information

Tools Menu
Manage Prompts

Types of prompts
Feedback Prompt Management
Creating new prompts

2



32
33
33
34
34
34
34
34
34
35
35
37
37
37
38
38
38
38
38
38
38
38
38
38
38
39
39
39
39
39
39
39
39
39
39
40
40
40
40
41
41
41
41
41
41
41
41
41
41
41
42
42
42
42
42
42
42
43
43
43
43
44
44
44
44

Editing prompts
Deleting a prompt
Creating a prompt from a WAV file

Manage Question Categories
Question Categories
Adding categories
Deleting categories

Manage Rankings
Defining a Rank group
Defining the ranking scale
Assigning a Ranking to a survey

Interaction Feedback Reporting
Interaction Feedback Reports

Survey Reports
Miscellaneous topics

Create Group
Name
Description

Dashboard View
Speedometer pointer
Ranking
Odometer
Survey name
Starting Date
Date field

Library Pane
Manage Dashboard

Survey
Starting Date
Date field
Add
Up and Down
Remove

Menu Bar
Navigation Pane
Prompt Edit

Prompt Audio box
Listen to Prompt
Prompt Information

Prompt Management
Add
Edit
Delete
Import

Question Categories
Add
Delete

Question View
Name
Description
Question prompt
No Input prompt
No Match prompt
Question Weight
Ignore score for question
Retries
Timeout
Question Categories
Branching
Scoring Values
Free Form Recording
Reordering Questions

Rank Groups
Create a Rank Group
Define a ranking scale

3



45
45
45
45
45
45
45
46
46
46
46
46
46
46
46
47
47
47
48

Search Attributes
Ranking
Scored User
Survey Name
Survey State
Advanced Search Attributes

Survey Definition Pane
Survey Group View

Name
Description

Survey Activation
Total surveys defined
Total surveys activated
Survey list

Survey Results Pane
Toolbars
Workspace Tabs
Workspace

Change log

4



About Interaction Feedback
Welcome to Interaction Feedback, an IC Business Manager application program module that supports automated post-call
customer satisfaction surveys and on-demand surveys. Interaction Feedback has an intuitive user interface to help you build
effective satisfaction surveys that ask your customers discerning questions about your company's products and services.

Here's an overview of Interaction Feedback features.

Interaction Feedback Client
Interaction Feedback, an IC Business Manager add-on module, allows you to create customer satisfaction surveys using the
Interaction Feedback Create Survey Wizard. Surveys can be created using pre-defined industry standard templates, or customized
questions can be easily created using Interaction Feedback Tools. Completed survey results are viewed using the Interaction
Feedback Dashboard, giving you immediate insight into your customers' experiences.

Real-time monitoring in IC Business Manager
An Interaction Feedback Statistics View in IC Business Manager provides you with the ability to view real-time statistics for surveys
in progress, surveys customers are in the process of taking. Interaction Feedback takes advantage of the Interaction Supervisor
Alerting mechanism, allowing you  to receive immediate notifications when surveys fail to meet a minimum acceptable score.
Using real-time monitoring helps you understand what you are doing well and what immediate actions might need to be taken to
meet customer expectations.

Interaction Feedback Reports
Interaction Feedback Reports are available in Interaction Reporter in IC Business Manager. These pre-defined reports contain
summary and detailed information on completed customer satisfaction surveys.

Interaction Administrator configuration
After installation, Interaction Feedback is readily configured in Interaction Administrator. Licensing for accessing Interaction
Feedback features is also controlled in Interaction Administrator. For more information, see the Interaction Feedback Technical
Reference, available in the PureConnect Documentation Library on your CIC server. The latest version of this document can also be
accessed from the PureConnect Documentation Library at help.genesys.com.

For a list of additional resources for Interaction Feedback, see Review Interaction Feedback Resources.

Related Topics

Interaction Feedback Navigation Pane

Interaction Feedback User Interface
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Interaction Feedback User Interface
Interaction Feedback Client uses the IC Business Manager user interface, which makes it easier to navigate your options when
creating and viewing customer surveys. The interface includes menus, toolbars, navigation panes, and a workspace. For basic
information on using the IC Business Manager interface, see Getting Started on the Help menu.

To learn more about the Interaction Feedback user interface features, pause the mouse pointer over the menu bar, toolbar,
navigation panes, or workspace on the graphic below, and click to display more information.

 

For more information on the easy-to-use navigation features, see Interaction Feedback Navigation Pane.

 

 

6



Interaction Feedback Navigation Pane
The Interaction Feedback navigation pane provides easy access to its survey features in the following navigation panes: Survey
Results, Survey Definition, and Library.

To learn more about the Interaction Feedback Navigation Pane, pause the mouse on one of the panes below, and click to display
more information.

7



 
8



Related Topics

Dashboard View

Interaction Feedback User Interface

Question View

Survey View
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Review Interaction Feedback Resources
Because Interaction Feedback is integrated with Customer Interaction Center, there are additional technical references and guides
that include Interaction Feedback information. Documents are available in the PureConnect Documentation Library on your CIC
server.

The latest versions of these documents can also be accessed from the PureConnect Documentation Library on the PureConnect
website at:
help.genesys.com

For additional information about Interaction Feedback features, see the following technical references, Help, and links:
Interaction Feedback Technical Reference
PureConnect Installation and Configuration Guide
IC Business Manager  Help
PureConnect Data Dictionary
Interaction Supervisor Help
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Creating Customer Surveys
Interaction Feedback provides tools that help you easily build customer surveys and view survey results.

For more information, see About Customer Surveys.

About Customer Surveys
Interaction Feedback provides a simple solution to building surveys for measuring customer satisfaction. There are two types of
surveys, Post-Call Survey and On-Demand Survey. An Interaction Feedback automated survey assists you in gathering and analyzing
customer feedback faster and better than conventional survey methods.

An Interaction Feedback post-call survey contains:
Rule Conditions that determine which customer calls will be offered the opportunity to take a survey.
Prompts which invite the customer to take a survey, welcome the customer to the survey, and thank the customer for taking the
survey.
Questions that measure a customer's perception on satisfaction with the overall experience of the call, customer feedback on
the agent's skills and knowledge, and the likelihood that the customer might buy or recommend your company's products.

An on-demand survey contains Prompts and Questions.

For basic steps to create a survey, see Creating Surveys.

Creating Surveys
The following links are meant to familiarize you with the basic steps you'll need to create Post-call and On-demand surveys.

The basic steps in creating a survey are:
1. Create a survey group
2. Add a survey to a group
3. Add questions to the survey
4. Activate the survey

Detailed instructions, including steps with graphics, on creating custom surveys are in the Interaction Feedback Technical
Reference. This document is available in the PureConnect Documentation Library on your CIC server. The latest version of this
document can also be accessed from the PureConnect Documentation Library at help.genesys.com.

 

 

 

 

 

 

 

 

Customized surveys
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Creating a Survey Group
Create survey groups to organize surveys into logical groups and to control user access to those surveys.

To create a survey group:
1. From the Interaction Feedback Navigation Pane, under Survey Definition, select Survey Definition. The Add Group button is now

available on the Toolbar.
2. Click the Add Group button. The Create New Group dialog is displayed.
3. Type a Name and Description for your new group, and click OK. The new survey group is added to the bottom of the survey

group list and is indicated by the group icon .

To learn how to create a new survey for a group, see Adding a Survey to a Group.

 

 

 

 

 

 

 

 

 

Adding a Survey to a Group
Use the Create Survey Wizard to add a new survey to a group. There are two types of surveys that can be created: Post-Call survey
in which the caller chooses to participate, or an On Demand survey that is initiated through Interaction Attendant.

To create a survey:
1. Under Survey Definition, select the survey group to which you want to add a survey. The Add Survey button is now available on

the toolbar.
2. Click the Add Survey button. The Create Survey Wizard starts.
3. Click Next and follow the wizard instructions to create a new custom survey or to create a survey from a template.

Notes for On-demand surveys
     - On-demand IVR surveys are initiated in Interaction Attendant.
     - An on-demand survey must be marked Active in order to be available for use in Interaction Attendant.
     - For detailed instructions on adding an on-demand survey to an Interaction Attendant profile, see the Help topic, “Add
inbound IVR surveys to Interaction Attendant profiles” in the Interaction Attendant Help.

After creating a survey, the next step is adding questions to your survey. To learn more, see Adding Questions to a Survey.
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Adding Questions to a Survey
Use the Create Question Wizard to add questions to a survey. Questions can be added when you are creating a survey, or you can
add questions to an existing survey.

Questions can be added at the completion of the Create Survey Wizard.  

To add a question at the end of creating a survey:
1. On the last screen of the Create Survey Wizard, select the Create question now check box.
2. Click Finish. The Create Question Wizard is started.
3. Follow the wizard instructions to create one or more survey questions.

Questions can be added using the Create Question Wizard.

To add a question to an existing survey:
1. Under the survey group, select the survey. the Add Question button is now available on the toolbar.
2. Click Add Question on the toolbar. The Create Question Wizard is started.
3. Follow the wizard instructions to create one or more survey questions.

 

Detailed instructions on using the Create Survey Wizard to add a question to a survey are in the Interaction Feedback Technical
Reference, available in the PureConnect Documentation Library on your CIC server. The latest version of this document can also be
accessed from the PureConnect Documentation Library at help.genesys.com.

 

Related Topics

Activating a Survey

Editing Questions

 

 

 

 

 

 

 

 

Adding questions when creating a survey

Adding questions to an existing survey
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Editing Questions
Questions can be edited in the Interaction Feedback Question view, which is displayed in the workspace.

To edit the settings for a question:
1. In the Survey Definition pane, under the survey, select the question. The question properties are displayed in the workspace.
2. Enter your changes, and when you have finished, right click and in the shortcut menu, select Save question.

Note  You can change the order questions appear in a survey. To do this, from the Interaction Feedback Navigation Pane, select
a Question in a Survey. Right-click on the Question, and on the shortcut menu click Up or Down. The position of the question is
reordered in the survey.

Detailed instructions on using the Create Survey Wizard to add a question to a survey are in the Interaction Feedback Technical
Reference, available in the PureConnect Documentation Library on your CIC server. The latest version of this document can also be
accessed from the PureConnect Documentation Library at help.genesys.com.

For a quick look at the available question settings, see Question View.

 

 

 

 

 

 

 

 

 

Adding branching logic to a survey
Adding branching logic to a survey allows the survey to change according to user responses to specific questions.  In a survey with
branches, relevant questions are offered according to the user’s specific situation. With branching, questions can be skipped or
another question can be asked based on the user response to a branching question.

After your survey has been created and you have added all your questions to the survey, you can add branching to specific survey
questions. Branching is configured in the Interaction Feedback Question View. Branching options can be configured for the
following question types: True/False, Multiple Choice, and Numeric Range. Free Form (recording) questions cannot be configured
as a branching question. Each question type has its own set of branching options.

For step-by-step instructions on configuring each question type for branching logic in your survey, see “Appendix B.  Add branching
logic to a survey" in the Interaction Feedback Technical Reference, available in the PureConnect Documentation Library on your CIC
server. The latest version of this document can also be accessed from the PureConnect Documentation Library at
help.genesys.com.
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Activating a Survey
Activating a survey makes it available to CIC server for post-call customer surveys and on-demand surveys. An active survey cannot
be modified.

There are two ways to activate a survey, in the Survey view and in the Survey Activation view.

To activate a survey while viewing a survey:
1. In the Survey Definition pane, select the name of the survey to be activated. The survey is displayed in the workspace.
2. Click Activate.

To activate a survey from a list of all available surveys:
1. In the Survey Definition pane select Survey Definition. The Survey Activation view is displayed in the workspace.
2. From the list of surveys, select the name of the survey you want to activate.
3. Click Activate.

Related Topics

Deactivating a Survey

 

 

 

 

 

 

Activating a survey in Survey view

Activating a survey in Survey Activation view
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Deactivating a Survey
In order to modify an activated survey, it must be deactivated.

There are two ways to deactivate a survey, in the Survey view and in the Survey Activation view.

To deactivate a survey while viewing a survey:
1. In the Survey Definition pane, select the name of the survey to be deactivated. The survey is displayed in the workspace.
2. Click Deactivate.

To deactivate a survey from a list of all available surveys:
1. In the Survey Definition pane select Survey Definition. The Survey Activation view is displayed in the workspace.
2. From the list of surveys, select the name of the survey you want to deactivate.
3. Click Deactivate.

When you click Deactivate, a confirmation dialog is displayed with three choices: Yes, No, or Cancel.
When you choose Yes, all previous survey results will be purged, and the survey is deactivated.
When you choose No, survey results are not purged and the survey is deactivated. Previous survey results will be mixed with
new survey results. Consider selecting No if you are changing something minor. However, this might cause confusion in long-
term reporting, for example if you add a new question.
When you choose Cancel, survey results are not purged and the survey is not deactivated.

Related Topics

Activating a Survey

 

 

 

 

 

 

Survey View
The Survey view displays current settings for the selected survey. Use this view to change and update survey settings.

This field displays the Type of survey. There are two types of surveys: Post-Call survey and On Demand survey.

The survey name is displayed. Use this field to change the name.

The description for the survey is displayed. The text in the Description box is displayed as a tooltip when you pause the mouse over
the survey in the Survey Definition pane. Use this field to make changes to the description of the survey.

Deactivating a survey in Survey view

Deactivating a survey in Survey Activation view

Type

Name

Description
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The Rank Group box displays the currently selected Rank Group for this survey. Use the arrow in the drop-down box to select a
different Rank group from the list.

Select this box if you want to record the audio portion of a Post-Call survey. This recording option is not available for On-demand
surveys. Do not select this box if you use Interaction Recorder to record calls.

Use this field to set a minimum score for this survey. Enter the Minimum Acceptable Score as a percentage of the maximum score
for the survey. Click the information icon, next to the Minimum Acceptable Score box, to display a tooltip that assists you in
selecting the percentage for the minimum acceptable score for the survey. The Minimum Acceptable Score percentage is the
number that is used for Alert notification in Interaction Supervisor.

Use the Rule page to add a rule for a Post-Call survey, change the rule settings, or remove a rule from a survey. This page is not
available for On-demand surveys.

Add a rule

To add a Rule to a survey:
1. In the Rule Conditions list, select the check box
2. In the Rule description box, click the highlighted value to edit
3. In the dialog that is displayed, set the values for the rule.

Edit a rule

To edit a value for a Rule value:
1. In the Rule description box, click the highlighted value of the rule to edit
2. In the dialog that is displayed, update the values for the rule.

Note  Rule Condition values are case sensitive. When setting a Rule Condition <value> for an <attribute>, the specified value
must be an exact match to the value of the Attribute associated with the call. For example, if the call attribute has a value of
true and the Rule Condition value is set to True, the survey will not be offered.

Remove a rule

To remove a Rule from a survey, in the Rule Conditions list, clear the check box.

Use the Prompts page to edit prompts for this survey.

Invitation

This Post-Call survey prompt is presented to the caller at the beginning of the interaction to participate in a survey at the end of the
call. In the Invitation box, use the arrow in the drop-down list to select a prompt that invites the customer to participate in this
survey. Note, you can also configure this post-call survey prompt to automatically present a survey to the caller by setting the
Invitation prompt to None.

The Invitation prompt is not displayed for On-demand surveys.

Rank Group

Record calls that use this survey

Minimum Acceptable Score

Rule

Prompts
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To preview the selected prompt, click the play button .

To create a new prompt, select [add recording], and use the Prompt Edit dialog to add a new prompt.

Opt-in

This Post-Call survey prompt is presented when the customer has chosen to take the survey, and it requests that the customer stay
on the line after the interaction has concluded. In the Opt-in box, use the arrow in the drop-down list to select a prompt. This prompt
is not displayed for On-demand surveys.

To preview the selected prompt, click the play button. To create a new prompt, select [add recording], and use the Prompt Edit
dialog to add a new prompt.

Opt-out

This Post-Call survey prompt is presented when the user has chosen not to take the survey. In the Opt-out box, use the arrow in the
drop-down list to select a prompt. This prompt is not displayed for On-demand surveys.

To preview the selected prompt, click the play button. To create a new prompt, select [add recording], and use the Prompt Edit
dialog to add a new prompt.

Welcome

This prompt welcomes the customer to the Post-Call survey and the On-Demand survey and provides instructions on how to take
the survey, such as hot to repeat a question or how to skip a question. In the Welcome box, use the arrow in the drop-down list to
select a prompt.

To preview the selected prompt, click the play button. To create a new prompt, select [add recording], and use the Prompt Edit
dialog to add a new prompt.

Finish

This prompt is presented at the completion of a Post-call survey and On-Demand survey. In the Finish box, use the arrow in the drop-
down list to select a prompt.

To preview the selected prompt, click the play button. To create a new prompt, select [add recording], and use the Prompt Edit
dialog to add a new prompt.

 

For additional information on creating a new prompt for your survey using the Prompt Edit dialog, see Prompt Edit .
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Creating Templates
You can create question and survey templates from existing questions and surveys.

For more information, see About Templates.

 

 

 

 

 

 

 

 

 

 

 

About Templates
Templates are created from existing surveys and questions. Templates save the settings for surveys and questions, saving you
time when creating new surveys. Templates are saved in the Library for reuse.

For more information, click on a link below:
 Creating Survey Templates
 Creating Question Templates.
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Creating Survey Templates
Survey templates save the settings for existing surveys and save you time when creating new surveys.

To create a survey template from an existing survey:
1. In the Survey Definition pane, select the survey.
2. Click Copy to Survey Library on the toolbar.

The survey template is added to the Library and is indicated with a survey template icon .

For additional information on creating other templates, see Creating Question Templates.

 

 

 

 

 

 

 

 

 

 

Creating Question Templates
Question templates save the settings for existing questions and save you time when creating new surveys.

To create a question template from an existing question:
1. In the Survey Definition pane, select the question.
2. Click Copy to Question Library. on the toolbar.

The new question template is added to the Library and is indicated with a question template icon.
 

To learn about removing custom questions that have been copied to the Question Library, see Deleting Custom Questions from the
Library.

For additional information on creating other templates, see Creating Survey Templates.
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Deleting Custom Questions from the Library
You can remove custom questions that have been copied to the Question Library. To delete a question, the User must have the
Access Rights to Modify All surveys.

To remove a custom question from the Library:
1. In the Library pane, select the question to be deleted.
2. Right-click and on the shortcut menu, click Delete item.

You can only delete questions you have added to the Library.

For information on creating custom questions, see Creating Question Templates.
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Viewing Survey Results
You can view completed survey results in the Interaction Feedback Workspace, using the Dashboard or Searches. You can also
monitor surveys in real-time using Interaction Feedback Statistics View.

To learn about viewing survey results, click one of the following links:
Viewing Survey Results in Interaction Feedback
Monitoring Surveys in Real-Time

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Viewing Survey Results in Interaction Feedback
There are two ways to view completed surveys using Interaction Feedback, the Dashboard and Searches. Use the Navigation Pane
to display these views in the workspace.

For the steps to view completed survey results in Interaction Feedback, see:
Viewing Survey Results in the Dashboard
Viewing Survey Results Using Searches
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Viewing Survey Results in the Dashboard
Use the Dashboard to view a summary of individual survey results. From the Interaction Feedback Navigation Pane, under Survey
Results, click Dashboard. The Dashboard view is displayed in the workspace.

 

Use the Manage Dashboard toolbar button to add individual survey results to the Dashboard. Results are graphically displayed as a
speedometer.

 

Managing the Dashboard
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The graphical interface shows the average score for surveys completed since the selected Starting Date. The speedometer also
displays the rank and the number of completed surveys.

The Dashboard speedometer gives you a quick view of completed survey results. A speedometer is displayed for each survey that
has been added to the view using Manage Dashboard.

Speedometer pointer

The average score for the surveys taken is indicated by the pointer, between 0 and 100.

Ranking

The average ranking of a survey is displayed on the face of the speedometer. The text that is displayed depends on the Rank label
assigned when creating the Rank Group.

Odometer

The number of completed surveys is displayed by the odometer.

Survey name

The survey name is displayed below the speedometer.

Starting Date

Select this check box to display data for a range of dates beginning with a specific date to the current day.

Date field

Enter a specific date for which to display completed survey results. If the Starting Date check box is selected, the average
completed survey results, beginning with this date to the current day, are displayed.

The Dashboard view is updated with completed survey results every three minutes, or when refreshed. To refresh the view, right-
click on the Dashboard, and on the shortcut menu click Refresh.

To display completed survey results in the Interaction Feedback workspace:

1. From the toolbar, click the Manage Dashboard button .
The Manage Dashboard dialog is displayed.

Dashboard View

Dashboard Speedometer

Refreshing the Dashboard view

Defining Surveys to display in the Dashboard
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2. From the Survey drop-down list, select the survey to be displayed.
3. To display survey results for a range of dates beginning with a specific date to the current day, select the Starting Date check

box. Next, in the date field drop-down, select a starting date on the calendar that is displayed.

Or, to display survey results for a specific date, clear the Starting Date check box, and in the drop-down calendar select the date
for which you want the data to be displayed.

4. Click Add. The survey is added to the Survey list, and the survey is displayed on the Dashboard.
5. Continue to define as many surveys as you want to display on the Dashboard. When you have completed defining surveys, click

Close.

The Dashboard is populated with the completed survey speedometers you have created.

 

For the steps to create searches to display completed survey information in Interaction Feedback, see Viewing Survey Results
Using Searches.

Viewing Survey Results Using Searches
Create Public Searches and Private Searches to display completed survey results, in table form. After creating a search, use Run a
Search to view the survey results in the workspace.

1. Select either the Public Searchers folder or the Private Searches folder and right-click the selection.

Create a search
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2. On the sub-menu, point to New, and then click Search. The search properties are displayed in the workspace.
3. The default search name is displayed in the Title box. To rename the search, type a new name.
4. To add an attribute to the search, click the New Attribute arrow.

5. Point to Survey, and click the search attribute you want to add to your search.

6. Select each attribute's search criteria and comparison operator.

 Use this button to add additional search criteria to an attribute.

 Use this button to delete a search criterion from an attribute.

7. To save a search, click Save Search    on the toolbar.

Note  
You can also create Public and Private Searches using the Menu Bar and the Toolbar. Using the Menu Bar, from the File menu,
point to New and click Search. On the Select Search Location dialog, select Private Searches or Public Searches. To create a
new Interaction Feedback search using the Toolbar, click New, and on the Create New View dialog, click OK. On the Select
Search Location dialog, select Private Searches or Public Searches.

Surveys are searched using the attributes in the way they are ordered from top to bottom. Use the green arrows  to
change the order of the search attributes

Use the delete   button to delete a selected attribute.

Search order

Run a search
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To run a search, under Survey Results, select the search, and click Run Search  on the toolbar. The search results are
displayed in the workspace.

Note  To paste Survey Results information into another application, use Ctrl+C in the Search Results grid to Copy an entire row,
or multiple rows, to the clipboard.

Selecting Fields for the grid

To change the Fields that are displayed in the grid, click the Field Chooser  on the top left of the grid.
In the Field Chooser dialog select the Fields to display in the grid.

The available fields for the search results grid are described in the following table.
27



Field Chooser

Field Description

Agent Name of the agent whose call is associated with this  survey

Caller Name of the caller who opted-in to take the survey

Completed Indicates a True or False value, True indicating all required survey questions were completed, and False indicating
all required survey questions were not completed

Date The Date and Time the survey occurred

Duration in
seconds

The total time, in seconds, for the caller to take the survey

Interaction
ID

The Interaction ID of the call associated with the survey

Origin  How the call came in to the system—possible values: Post-Call (used for opt-in surveys), External, Internal,
Transfer, or Outbound

Rank The Rank, or grade, based on the score associated with the survey rank group

Recording ID The Recording ID of the call associated with the survey

The Recording ID is displayed as a dynamic link. To listen to the recording, click the link to launch the Interaction
Recorder playback dialog.

Score Total survey score

State Current state of the survey, which include:
Abandoned — The caller hung up during the survey and the survey was abandoned
Complete — The survey was completed
Insufficient Resources — Licensing or some other resource was not available to present the survey
Opt-Out — The caller opted out of the survey
Error — There was an internal error when attempting to present the survey
Not Answered — The call was not answered by an agent
Caller Disconnect — The caller disconnected before the survey began

Survey Name Name of the survey

Type The type of survey, either Post-Call or On Demand

 

 

For the steps to display completed individual survey results in Interaction Feedback, see Viewing Survey Results in the Dashboard.
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Monitoring Surveys in Real-Time
Monitor Interaction Feedback surveys in real-time and create alerts using the Interaction Feedback Statistics View.

The Interaction Feedback Statistics View is accessed in IC Business Manager. It provides the ability to view real-time statistics for
surveys in progress—surveys customers are in the process of taking.

Interaction Feedback real-time monitoring allows you to create Alerts for surveys that are in progress.

For information on starting the Interaction Feedback Statistics View in IC Business Manager, to monitor surveys in real-time,
see, "Monitoring surveys in real-time" in the Interaction Feedback Technical Reference. The latest version of this document can
also be accessed from the PureConnect Documentation Library at help.genesys.com

For complete information on Interaction Feedback Statistics View, see the Interaction Supervisor Help in IC Business Manager.

 

 

 

 

 

 

 

 

For more information
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Tools Menu
Interaction Feedback has a suite of tools to manage Interaction Feedback's Prompts, Question Categories, and Rankings.

To access these tools, click the Tools menu.

 

To learn more about the available Tools for Interaction Feedback, click one of the following links:
Manage Prompts
Manage Question Categories
Manage Rankings

 

Manage Prompts
Access Manage Prompts from the Tools menu.

Prompts are pre-recorded audio files that invite the customer to participate in a survey, welcome the customer to the survey, ask
the customer specific customer satisfaction questions, and thank the customer for taking the survey.

You can select prompts from existing Interaction Feedback prompts or create your own prompts.

These are the types of prompts that you will be selecting on Interaction Feedback dialogs when creating surveys and questions.

Invitation

This prompt invites the customer, at the beginning of a call, to participate in a survey at the end of a call. You can also configure
this prompt to automatically present a survey to the caller by setting the prompt to None.

Opt-in

This prompt recognizes that the customer has chosen to take the survey, and requests that the customer stay on the line after the
call has concluded.

Welcome

This prompts welcomes the customer to the survey at the end of the agent interaction and provides instructions on how to take the
survey, such as how to repeat a question or how to skip a question.

Questions

These prompts contain the specific questions that measure customers' perceptions on satisfaction with the overall experience of
the call, customer feedback on the agent's skills and knowledge, and the likelihood that the customer might buy or recommend your
company's products.

Types of prompts
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No Input Prompt

This is the prompt that is played if there was no response to the question.

No Match Prompt

This is the prompt that is played if the customer's response is invalid.

Finish

This prompt is played at the completion of the survey and thanks the customer for taking the survey.

Use the Feedback Prompt Management tool to create new prompts, edit existing prompts, delete prompts, and import WAV files for
new prompts.

To access the Feedback Prompt Management dialog, from the Tools menu, click Manage Prompts. The Feedback Prompt
Management dialog is displayed.

Available prompts are listed by Name, File and Description. To sort the list of prompts, click a column heading.

To create a new prompt, click Add. The Prompt Edit dialog is displayed.

Feedback Prompt Management

Creating new prompts
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Prompt Audio

To record an audio prompt from your telephone, select Station handset record, and click Record. To use an existing audio file for
your prompt, select WAV file selection, and click Browse to select the file path.

Listen to Prompt

To listen to the prompt, in the Play To box, select the output device, and click Play.

Prompt Information

Type the name for this prompt in the Name box. Type the full text of this prompt in the Description or text to speech if no prompt
has been added box. This text also appears in the Description column.

When you have completed the Prompt Edit dialog, click Save to add your new prompt to the list of prompts.

On the Feedback Prompt Management dialog, select the prompt, and click Edit. The Prompt Edit dialog is displayed with the current
prompt settings.

Editing prompts
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After updating the prompt properties, click Save.

Use the Feedback Prompt Management dialog to delete an existing prompt. From the Tools menu, click Manage Prompts.

To delete an existing prompt, select the prompt in the Feedback Prompt Management dialog, and click Delete.

Use the Feedback Prompt Management dialog to create a prompt from an existing WAV file.

To create a prompt, click Import. The Select one or more prompt WAV files to import dialog is displayed. Locate and select the file
name, and click Open.

A prompt is created using the WAV file name as the name of the prompt. To edit the prompt, select it and click Edit.

Deleting a prompt

Creating a prompt from a WAV file
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Related Topics

Manage Question Categories

Manage Rankings

 

Manage Question Categories
Access Manage Question Categories from the Tools menu.

Question Categories are created to organize questions in to logical groups.

Use the Question Categories dialog to create and delete these categories. To access the Question Categories dialog, from the
Tools menu, click Manage Question Categories. The Question Categories dialog is displayed.

To create a new category, click Add. A New Category is created and selected. Type a Category Name and press Enter.

To delete an existing category, select it and click Delete.

 

Related Topics

Manage Prompts

Manage Rankings

 

Manage Rankings
Access Manage Rankings from the Tools menu.

Rankings are scaled scores used to rate or grade customer surveys. When a survey is completed, the final score is compared to the
value defined in the survey's ranking. When viewing survey results, the rank is displayed in searches and the Dashboard.

Define ranking scales on the Questionnaires Rank Groups dialog.  Assign a Rank Group to a survey on the survey configuration
page.

To access the Questionnaires Rank Groups dialog, from the Tools menu click Manage Questionnaire Rankings. The Questionnaires
Rank Groups dialog is displayed.

Question Categories

Adding categories

Deleting categories

Defining a Rank group
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To define a new ranking scale for a Questionnaire, first create a new Rank Group.
1. On the toolbar click New Group. The New Rank Group is displayed under Rank Groups at the end of the list.
2. In the Rank Groups list, right-click New Rank Group and click Rename to name the new Rank Group.
3. Type the new name for this rank group, and press Enter. The new name is displayed in the Group Name box in the Rank Groups

view.

To define the ranking scale for a group, select the Rank group, and edit its properties in the right pane.  
1. To add a Rank, click Add.
2. New Rank is added to the Rank list and is selected. Type a name for the ranking.
3. Use the Ranks percentage slider to select a Top Percent for the ranking.

Define as many ranks as you choose to use in your ranking scale, assigning a Top Percent to each ranking. The Top
Percent is the percentage of total possible points in the survey that will be using the scale, and it defines the upper limit
of the rank. The lower limit for each rank is one percent higher than the top percentage of the rank directly beneath it, or
zero if there is no lower rank.

4. Click Save, and then click Close to exit the Questionnaires Rank Group dialog.

To assign a ranking to a survey, view the survey in the workspace.

Defining the ranking scale

Assigning a Ranking to a survey
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In the Rank Group drop-down list, select a rank group to apply to the survey.

 

Related Topics

Manage Prompts

Manage Question Categories
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Interaction Feedback Reporting
Interaction Feedback reports are available through Interaction Reporter in IC Business Manager. For more information see
Interaction Feedback Reports.

 

 

Interaction Feedback Reports
The results of the customer satisfaction survey data are collected, aggregated, and presented in Interaction Reporter in IC Business
Manager. Reports include data from completed surveys. You can view, export, and print customer satisfaction survey reports.
Reports are based on completed customer surveys.

Note
If your survey contains a Free Form response as the last question, and the customer hangs up instead of pressing any key to
complete the response, the survey state is marked Complete and the Complete Field for the report is marked as True.
Comments that are ended by hanging up are displayed in the reports.

There are four reports that contain summary and detailed information on completed customer satisfaction surveys.

The reports include survey details including: user, average score, percentile, survey participant (Tracker contact), and specific
scores by questions. The reports provide information for comparison between different users' average survey scores over time.

The following reports are available for Interaction Feedback surveys:

Satisfaction Trends (Line Graph)

Shows satisfaction trend for an agent over time by survey.

Survey Scoring Detail

Shows detailed information related to the question of the specified survey and the average score for the agent during a date and
time range. Note As this report contains a Bar Chart, limiting the number of users selected for a report might provide graphs that are
easier to read.

Survey Scoring Summary

Shows the survey average score for the agent during a date and time range. This report also shows the Average score and
Percentile per user for the selected surveys. Note As this report contains a Bar Chart, limiting the number of users selected for a
report might provide graphs that are easier to read.

Survey vs. Quality Scores

Compares survey and quality scores for a given agent. If Interaction Recorder data is available, a report shows comparisons
between survey scores and quality scores.

 

Note  The PureConnect Data Dictionary includes information on the Interaction Feedback Tables. In addition to that information,
the following link is to the  Interaction Feedback Entity Relationship Diagram (ERD)

Survey Reports
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Miscellaneous topics

Create Group
Use this dialog to create a new group for surveys.

Type a name for the new group.

Type a description for identifying the types of surveys in this group. This description appears as a tooltip when you pause the
mouse pointer over the name of the group under Survey Definition.

 

Dashboard View
The Dashboard speedometer gives you a quick view of completed survey results. A speedometer is displayed for each survey that
has been added to the view using Manage Dashboard. The Dashboard data is updated every three minutes, or when refreshed. To
refresh the data, right-click on the Dashboard, and on the shortcut menu click Refresh.

The average score for the surveys taken is indicated by the pointer, between 0 and 100.

The average ranking of a survey is displayed on the face of the speedometer. The text that is displayed depends on the Rank label
assigned when creating the Rank Group.

The number of completed surveys is displayed by the odometer.

The survey name is displayed below the speedometer.

Select this check box to display data for a range of dates beginning with a specific date to the current day.

Enter a specific date for which to display completed survey results. If the Starting Date check box is selected, the average
completed survey results, beginning with this date to the current day, are displayed.

 

Name

Description

Speedometer pointer

Ranking

Odometer

Survey name

Starting Date

Date field
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Library Pane
The Library navigation pane contains survey templates and question templates to use when creating surveys. Library includes
custom surveys and question templates that you create. Survey templates are displayed when a survey is selected in the Survey
Definition pane, and Question templates are displayed when a question is selected.

 

Manage Dashboard
Use this dialog to add and remove surveys in the Dashboard view.

Select the name of the survey from the drop-down list.

Select this check box to display data for a range of dates beginning with a specific date to the current day.

Enter a specific date for which to display completed survey results. If the Starting Date check box is selected, the average
completed survey results, beginning with this date to the current day, are displayed.

Click Add to add the survey to the Survey list and display the survey in the Dashboard view.

Use these buttons to change the order that the surveys are displayed in the Dashboard view.

To remove a survey from the Dashboard view, select the survey and click Remove.

 

 

Menu Bar
Commands and actions are organized in menus that you use to work with Interaction Feedback. Click a menu title on the menu bar
to display a list of choices. To choose one of the commands listed on a menu, click it.

Navigation Pane
The Interaction Feedback navigation pane provides easy access to its survey features in the following navigation panes: Survey
Results, Survey Definition, and Library. It provides centralized navigation to survey components, which display their views in the
workspace next to the navigation panes.

Survey

Starting Date

Date field

Add

Up and Down

Remove
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Prompt Edit
Use the Prompt Edit dialog to add prompts to surveys and questions.

Station handset record

To record an audio prompt from your telephone:
1. Select Station handset record
2. In the drop-down box, select Telephone Handset
3. In the Station drop-down list, select the station for your handset
4.  Click Record.

To record an audio prompt from a remote telephone
1. Select Station handset record
2. In the drop-down box, select Remote Telephone
3. In the Number box, type the telephone number for the remote telephone
4.  Click Record.

WAV file selection

To use an existing audio file for a prompt, select WAV file selection, and click Browse to select the file path.

To listen to the prompt, in the Play To box, select the output device, and click Play.

Type the name for this prompt in the Name box.

Type the full text of this prompt in the Enter text-to-speech that will play box.

Prompt Audio box

Listen to Prompt

Prompt Information
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Prompt Management
Use this dialog to create new prompts, edit existing prompts, delete prompts, and import WAV files for new prompts. Available
prompts are listed by Name, File, and Description. To sort the list of prompts, click a column heading.

To create a new prompt, click Add. The Prompt Edit dialog is displayed.

To edit an existing prompt, select the prompt and click Edit. The Prompt Edit dialog is displayed.

To delete an existing prompt, select the prompt and click Delete.

To create a prompt from an existing WAV file, click Import. A dialog used to select WAV files is displayed. The prompt will be
named the same as the WAV file. To edit the new prompt and change the name, select it and click Edit.

 

Question Categories
Question Categories are created to organize questions in to logical groups. Use this dialog to create and delete Question
Categories.

To create a new category, click Add. A New Category is created and selected. Type a Category Name and press Enter.

To delete an existing category, select it and click Delete.

 

Question View
The Question view displays current settings for the selected question. Use this view to change and update question settings.

The Question name is displayed. Use this field to change the name.

The description for the question is displayed. The description usually includes the content of the question prompt for reference
purposes. The text in the Description box is displayed as a tooltip when you pause the mouse over the question in the Survey
Definition pane. Use this field to make changes to the description of the question.

Add

Edit

Delete

Import

Add

Delete

Name

Description
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The Question prompt is the actual question that measures the customer's overall experience of the call, including the customer's
feedback on the agent's skills and knowledge, and the likelihood that the customer might buy or recommend your company's
products. The Question prompt contains the specific audio for this question. The name of the Question prompt for this question is
displayed. To change the prompt, use the drop-down list to select a different prompt, or to create a new prompt, select [add
recording].

To listen to the selected prompt, click the play button  .

This is the prompt that the customer hears if there is no response to the question. The name of the No Input prompt for this
question is displayed. To change the prompt, use the drop-down list to select a different prompt, or to create a new prompt, select
[add recording].

To listen to the selected prompt, click the play button  .

This is the prompt that the customer hears if the response to the question is invalid. The name of the No Match prompt for this
question is displayed. To change the prompt, use the drop-down list to select a different prompt, or to create a new prompt, select
[add recording].

To listen to the selected prompt, click the play button  .

For additional information on creating a new prompt for your question using the Prompt Edit dialog, see Prompt Edit .

The Question Weight is used as a multiplier to calculate the final score for a question. For example, if the question is scored as a 9
with a weight of 2, the final score for that question is 18. The current value is displayed. Select the number for which you want to
weight the importance of this question. To change the value, enter the new value in the Question Weight box.

The Question Weight must be a non-zero value. It can be expressed as a decimal, for example 0.33, 1.5, or 5.55.

To not have the score for a question considered in the final score for the survey, use the Ignore score for question check box.

Select this box to not have the score for this question considered in the calculations for the final score of the survey.

The Retries value is the total number of times a question is repeated if there is an invalid response. If there is no response after the
number of retries, Interaction Feedback goes on to the next question. However, if there is no answer or no match for the first
question, Interaction Feedback abandons the survey, allowing for hang ups. After the first question is answered, the remaining
questions will go on to the next question if there is no answer or no match.

The Timeout value is the time, in seconds, to wait for a response after the Question prompt has been played. When the timeout
expires, the No Input prompt is played. To change the value, enter the new value in the Timeout box.

Question prompt

No Input prompt

No Match prompt

Question Weight

Ignore score for question

Retries

Timeout
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Question Categories organize questions in to logical groups. The categories that currently contain this question are displayed in
the Selected Categories box. To add  categories for this question, in the Available Categories box, select the categories in which

you want this question to be included. Click the arrow  to add the categories to the Selected Categories box.

To delete categories for this question, in the Selected Categories box, select the categories in which you want this question to be

deleted. Click the arrow  to delete the categories from the Selected Categories box.

Branching options can be configured for the following question types: True/False, Multiple Choice, and Numeric Range. Free Form
(recording) questions cannot be configured as a branching question. Each question type has its own set of branching options. For
step-by-step instructions on configuring each question type for branching logic in your survey, see “Appendix B.  Add branching logic
to a survey" in the Interaction Feedback Technical Reference, available in the PureConnect Documentation Library on your CIC
server. The latest version of this document can also be accessed from the PureConnect Documentation Library at
help.genesys.com

This field displays the various scoring values based on the type of question. One of the following scoring values is displayed,
depending on the question type.  

True/False

The scoring values for a True or False response are displayed. To change a value, enter the new value in the True Value or False
Value box.

Multiple Choice

Customers respond to multiple choice questions by pressing a DTMF key on the keypad . The scoring values for each key are
displayed in the Multiple Choice box. To change a setting for a multiple choice question, select the DTMF key to be changed, and
click Edit.

If you want to add a new DTMF key response, click Add.

To remove a DTMF key response, select the DTMF key and click Remove.

Numeric

Customers respond to a numeric question by pressing a DTMF key on the keypad. The range of numbers to score the question are
displayed in the Min and Max boxes. To change the minimum or maximum range for the score, enter a new value in the Min or Max
box.

Customers respond to a free form question by recording an audio response. The maximum recording length, in seconds, is
displayed in the Max recording length box. To change the allowed length of the recording setting, enter a new value in the Max
recording length box. To allow the customer the option to review a recorded response, select the Confirm Recording box.

When the customer is given the survey, the configured prompts are presented. You can localize the Free-form recording
confirmation prompts by configuring the value of the CSSurvey: Clear Language For Survey server parameter. The server parameter
default value of Yes clears the language attribute of the call. If you do not want to clear the language attribute of the call when a
survey begins, set the server parameter value to No. This allows the language attribute of the call to be used to localize the Free-
form confirmation prompts.

 

Question Categories

Branching

Scoring Values

Free Form Recording
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You can change the order questions appear in a survey. To do this, from the Interaction Feedback Navigation Pane, select a
Question in a Survey. Right-click on the Question, and on the shortcut menu click Up or Down. The position of the question is
reordered in the survey.

Rank Groups
Rankings are scaled scores used to rate, or grade, customer surveys. When a survey is completed, the final score is compared to
the value defined in the survey's ranking. When viewing survey results, the survey rank is displayed in searches and on the
Dashboard view.

Use this dialog to create a Rank Group and to define ranking scales for the group.

To create a Rank Group:
1. In the Rank Groups box, select Rank group.
2. Right-click to display the shortcut menu.
3. Click Add Group. A new folder, New Rank Group, is added to the list and highlighted.
4. To name the new rank group, right-click the selection, and click Rename.

To define the ranking scale for a group:
1. Select the Rank group. The right pane displays the properties for the rank group.
2. In the right pane, click Add. New Rank is added to the Rank list and is selected.
3.  Type a name for the ranking.
4. Using the Ranks percentage slider, select a Top Percent for the ranking.

Define as many ranks as you choose to use in your ranking scale, assigning a Top Percent to each ranking. The Top Percent is the
percentage of total possible points in the survey that will be using the scale, and it defines the upper limit of the rank. The lower
limit for each rank is one percent higher than the top percentage of the rank directly beneath it, or zero if there is no lower rank.

 

Reordering Questions

Create a Rank Group

Define a ranking scale
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Search Attributes
There are four search attributes for Survey:

The Survey Ranking attribute searches the selected Rank Group for surveys that match the selected rank using the comparison
operator.

The Survey Scored User attribute searches surveys for the selected agent using the comparison operator.

The Survey Name attribute searches surveys for the selected survey name using the comparison operator.

The Survey State attribute searches surveys for the selected survey state using the comparison operator.

The Advanced search attributes that apply to surveys include: Recording ID and Survey ID.

 

 

 

 

 

 

 

 

 

 

Survey Definition Pane
Use the Survey Definition navigation pane to create Survey Groups, create Customer Surveys, create survey questions, and to
activate a survey. Surveys and Questions are edited and managed in the Survey Definition pane.

Ranking

Scored User

Survey Name

Survey State

Advanced Search Attributes
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Survey Group View
The Survey Group view displays the current settings for the selected survey group. Use this view to update the Name and
Description of the survey group.

The Survey group name is displayed. Use this field to change the name.

The description for the survey group is displayed. The text in the Description box is displayed as a tooltip when you pause the
mouse over the group name in the Survey Definition pane. Use this field to make changes to the description for the survey group.

 

Survey Activation
When you select Survey Definition in the Interaction Feedback Navigation pane, the Survey Activation view is displayed in the
workspace. Use the Survey Activation view to Activate and Deactivate surveys.

Displays the total number of surveys defined under Survey Definition.

Displays the total number of surveys that are active.

This list contains all the current surveys and includes the survey Name, Group, Active (status), and Priority. To change the Priority in
which a survey is offered, use the Up and Down buttons.

To activate a survey, select the survey, and click Activate.

To deactivate a survey, select the survey, and click Deactivate.

 

Note  When you click Deactivate, a confirmation dialog is displayed with three choices: Yes, No, or Cancel.
When you choose Yes, all previous survey results will be purged, and the survey is deactivated.
When you choose No, survey results are not purged and the survey is deactivated. Previous survey results will be mixed with
new survey results. Consider selecting No if you are changing something minor. However, this might cause confusion in long-
term reporting, for example if you add a new question.
When you choose Cancel, survey results are not purged and the survey is not deactivated.

 

Survey Results Pane
The Survey Results navigation pane allows authorized users to display the results of completed surveys in the workspace, using the
Dashboard and Searches. Use the Dashboard for a quick graphical view of survey results by date. For more detailed survey results,
use the Public Searches folder and the Private Searches folder to build customized searches.

Name

Description

Total surveys defined

Total surveys activated

Survey list
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Toolbars
Interaction Feedback toolbars contain buttons that represent tasks you can do within the program. Click a button on the toolbar to
perform the task. To display toolbars, from the View menu, point to Toolbars and on the submenu, select the toolbar you want to
view.

Workspace Tabs

Workspace Tabs allow you to switch between IC Business Manager Modules. Click the Interaction Feedback tab to open the
Interaction Feedback module.

 

Workspace
Views selected in the Navigation Pane, such as Dashboard and Survey Definition, are displayed in the Workspace.
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Change log

Date Changes

12-March-2019 Created this change log.
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